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The information contained in this document is provided “as is” and is subject to change 
without notice. Cyberbank makes no warranty of any kind with regard to this manual, 
including, but not limited to, the implied warranties of merchantability and fitness for a 
particular purpose. Cyberbank shall not be liable for any errors contained herein or for 
incidental or consequential damages in connection with the furnishing, performance, or 
use of this manual or the examples herein. 
 
This document contains proprietary information that is protected by copyright. All rights 
are reserved. No part of this document may be photocopied, reproduced, adapted, or 
translated to another language without the prior written consent of Cyberbank, except as 
allowed under the copyright laws. 
 
The programs that control this product are copyrighted and all rights are reserved. 
Reproduction, adaptation, or translation of those programs without prior written 
permission of Cyberbank is also prohibited. Microsoft, ActiveSync, MSN, Outlook, 
Windows, Windows Media, Windows NT, and the Windows logo are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries. Microsoft products are licensed to OEMs by Microsoft Licensing, Inc., a wholly 
owned subsidiary of Microsoft Corporation. 
 
All other brand names and product names used in this document are trade names, 
service marks, trademarks, or registered trademarks of their respective owners. 
 
 
CYBERBANK. CORP. 
3, 4, 5th Fl. Mirae B/D Dogok-dong, Kangnam-gu, Seoul, Korea 

Copyright

Cyberbank assumes no responsibility for any damage or loss resulting from the 
use of this manual. And also Cyberbank assumes no responsibility for any 
damage or loss caused by deletion of data as a result of malfunction, dead 
battery, or repairs. Be sure to make backup copies of all-important data on other 
media to protect against data loss. 
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In August 1996 the Federal Communications Commission (FCC) of the United States with its action in 
Report and Order FCC 96-326 adopted an updated safety standard for human exposure to radio 
frequency electromagnetic energy emitted by FCC regulated transmitters. Those guidelines are consistent 
with the safety standard previously set by both U.S. and international standards bodies. The design of 
TRITON complies with the FCC guidelines and these international standards. 
Use only the supplied or an approved antenna.  Unauthorized antennas, modifications, or attachments 
could impair call quality, damage your TRITON, or result in violation of FCC regulations. 
Do not use your TRITON with a damaged antenna.  If a damaged antenna comes into contact with the 
skin, a minor burn may result. Please contact your local dealer for replacement antenna. 
 
TRITON was tested for typical body-worn operations using the optional belt-clip / holster placed touch 
(0cm) from the body.  To comply with FCC RF exposure requirements, a separation distance of touch 
(0cm) must be maintained between the user's body and TRITON, including the antenna, whether 
extended or retracted. The use of non-tested accessories or other body-worn operations may not comply 
with FCC RF exposure requirements and should be avoided.  Contact your local dealer for optional 
accessory items. 
 
For more information about RF exposure, please visit the FCC website at www.fcc.gov 
  
Specific Absorption Rate (SAR) for Wireless Phones 
 
The SAR is a value that corresponds to the relative amount of RF energy absorbed in the 
head of a user for a wireless handset. The SAR value of a phone is the result of an 
extensive testing, measuring and calculation process. It does not represent how much 
RF the phone emits. All phone models are tested at their highest value in strict laboratory 
settings. But when in operation, the SAR of a phone can be substantially less that the 
level reported to the FCC. This is because of a variety of factors including its proximity to 
a base station antenna, phone design and other factors. What is important to remember 
is that each phone meets strict federal guidelines. Variations in SARs do not represent a 
variation in safety. All phones must meet the federal standard, which incorporates a 
substantial margin of safety. As stated above, variations in SAR values between different 
model phones do not mean variations in safety. SAR values at or below the federal 
standard of 1.6W/kg are considered safe for use by the public. 
 
CDMA mode (Part 22)- Head: 1.46W/kg; Body-worn: 0.87W/kg 
 
 
 
FCC Radio Frequency Emission 
This phone meets the FCC Radio Frequency Emission Guidelines. FCC ID number: 
PGVCB-0880NP. More information on the phone’s SAR can be found from the following 
FCC website:  http://www.fcc.gov/oet/fccid 

FCC RF Exposure Information
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Please read these simple guidelines before using your phone. Failure to comply with these guidelines may 
be dangerous or illegal. 
 
Do not use a hand held phone whilst driving a vehicle; park the vehicle first. 
 
Switch off your phone when in an aircraft. The use of cellular phones whilst airborne is illegal in some 
countries. It may disrupt the operation of the aircraft. Follow any regulations or rules regarding air travel. 
 
Wireless phones can cause interference. Switch off your phone near medical equipment. 
 
Do not use your mobile phone at a petrol station or near fuel, chemicals or in any area where blasting is in 
progress. Observe restrictions and follow all rules and regulations. 
 
Use the phone only in a normal manner as instructed in this manual and do not handle the antenna 
unnecessarily. 
 
Only qualified service personnel must install or repair equipment. Breaking the warranty seal and opening 
the casing of the phone will void your warranty. 
 
Use only approved accessories and batteries. Do not connect to incompatible products. 
 
Avoid any contact with water and any type of moisture. 

Safety Information
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Acknowledging Special Precautions and  

the FCC Industry Canada Notice 
 

Cautions 
 

Modifications not expressly approved by the party responsible for compliance could void 
the user’s authority to operate the equipment. 
 
FCC compliance Information 
 
This device complies with part 15 of FCC Rules. 
When used a computer peripheral, 
Operation is subject to the following two conditions: 
1. This device may not cause harmful interference, and 
2. This device must accept any interference received. 
Including interference that may cause undesired operation. 
 
Information to User 
 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, Pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. 
 
This equipment generates, uses and can radiate radio Frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures: 
▪ Reorient or relocate the receiving antenna. 
▪ Increase the separation between the equipment and receiver 
▪ Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 
 
Consult the dealer or an experienced radio/TV technician for help. 
 
 

 

USER INFORMATION
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Congratulations on purchasing our PDA (personal digital assistant) device, Triton, 

powered by Microsoft® Windows® for Pocket PC. Your device lets you keep your most 

important business and personal information current and close at hand. Your device 

includes Microsoft Pocket PC Software 2003 second edition, which includes the latest 

version of Microsoft Pocket Outlook®, so you can read and write e-mail while on the 

road and manage your appointments and contacts. You will find that your device is also 

the perfect companion to your desktop or notebook PC, allowing you to take vital 

business data and documents with you and easily upload updated information. The 

device offers you the highest quality in performance and power management as well as 

rich programs and utilities designed by cyberbank. 

In this chapter, you will find:

- What’s in the Box? 

- Hardware Features 

- Using Stylus 

- Soft Reset & Hard Reset 

- Microsoft Pocket PC Software 

- The 3
rd

 party programs 

- Where to Find Information 

- Using This Manual 

Chapter 1

About Device
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What’s in the Box? 

Your device package includes the following items: 

Device
USB Cable 

AC Adapter 

Quick Start Guide 
(A graphic guide to 
setting up your device.) 

User's Manual 

Pocket PC Companion CD 
(Includes Microsoft 
ActiveSync® and Microsoft 
Outlook 2002 for your desktop 
PC, as well as programs and 
utilities that add functionality to 
your device.) 

USB Converter CableCradle 

Cyberbank CD 
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Hardware Features 

The illustrations below introduces you to the various buttons and other features of your 

device.

Camera Model 

1. Stereo headphone jack: Connect a stereo headphone provided by Cyberbank. 

2. USB slot(Host): Through USB Converter Cable, connect USB devices such as USB 

keyboard, USB drive to your desktop PC. 

3. SD (Secure Digital) card slot: Insert an optional SD card to add memory. 

4. CF (CompactFlash) card slot: Insert an optional CF card to add memory. 

5. Camera button: press this button to take a picture. 

6. Phone button: Press to turn your phone program on. 

7. Speaker: Listen to music or set audible reminders and alerts and hear the voice 

while communicating on the mobile phone. 

8. Touch screen (TFT LCD): Tap on-screen controls or buttons to select menu 
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commands or input text. 

9. Function key: easily enter the various functions. 

10. Navigation pad: Press to navigate through documents or select on-screen buttons 

and controls. 

11. Microphone: Speak into the microphone to record voice notes and communicate on 

the mobile phone. 

12. Number key: enter numbers. 

13. Power button: Press to turn your device on and off.  

14. Phone status LED: flashes when a phone-call comes in and displays the status of 

mobile phone. Notifies you of phone status including SMS.  

15. Antenna: used for built-in cellular module. 

16. Charging status LED: indicates power status while recharging. (Blue : fully charged, 

Red : charging) 

17. Camera button: press this button to take a picture. 

18. Infrared(IrDA) port: Beam files to other mobile devices. 

19. USB/Serial port: connect to desktop PC through the USB cable. 

20. Stylus: Use the stylus to navigate on the touch screen. 

21. Battery: removable Lithium Ion main battery(1800mAh). 

22. Reset switch: Use the stylus to press the reset switch and restart your device so that 

all your unsaved files will be deleted. 

23. Mirror: show your face. 

24. Camera Lens: Take a picture. 

25. Cradle port: connect to Cradle. 

26. PCMCIA expansion pack slot: connect to the optional expansion pack. 
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Using the Stylus 

Use the stylus to navigate and select objects on the screen. 

Pop-up menu 

With pop-up menus, you can quickly choose an action for an item. For example, you can 

use the pop-up menu in the contact list to quickly delete a contact, make a copy of a 

contact, or send an e-mail message to a contact. The actions in the pop-up menus vary 

from program to program. 

To access a pop-up menu, tap and hold the stylus on the name of the item that you want. 

When the menu appears, lift the stylus, and tap the action you want. Or tap anywhere 

outside the menu to close the menu without performing an action. 

Tap and hold to display the pop-up menu.

Lift the stylus and tap the action you want. 

Select from the pop-up menu to copy, 
delete, paste, select all, rename, move. 

Tap and hold 

Tap and hold the stylus on an item to see a list of actions available for that item. 

On the pop-up menu that appears, tap the action you want to perform. 

Drag

Hold the stylus on the screen and drag across the screen to select text and 

images. Drag in a list to select multiple items. 

Tap

Touch the screen once with the stylus to open items and select options. 
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Soft Reset & Hard Reset 

When your device is running slow or improperly, use the stylus to press the Reset switch 

(see the picture below). This is called “Soft Reset” in this manual. When you perform a 

Soft Reset, you will lose all unsaved data. Be sure to save all data in open documents or 

programs beforehand. This is similar to pressing the Reset switch on your desktop. 

Performing Hard Reset is to press the power button with a finger and press the reset 

switch with a stylus at the same time. When you perform Hard Reset, you will lose all 

information that is stored in the RAM. Be sure to save all data using ActiveSync or the 

Backup utility before you perform Hard Reset. 

Be sure to use the stylus provided by Cyberbank.
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 Microsoft Pocket PC Software 

Your device already includes the full suite of software you need to function as a mobile 

professional. These programs are introduced below. 

Detailed information can be found in later chapters. 

The programs listed below are preinstalled in Flash ROM. These preinstalled programs 

will not be deleted if your device suffers a loss of power.

 ActiveSync. Synchronize information between your device and desktop computer. 

 Calendar. Keep track of your appointments and create meeting requests. 

 Tasks. Keep track of your to-do list. 

 Contacts. Keep track of your friends and colleagues. 

 Notes. Create handwritten or typed notes, drawings, and recordings. 

 Inbox. Send and receive e-mail messages from your device. 

 Pocket Word. Create new documents or view and edit Word documents created on 

your desktop PC. 

 Pocket Excel. Create new workbooks or view and edit Excel workbooks created on 

your desktop PC. 

 Microsoft Pocket Internet Explorer. Browse the Web and view channels and 

subscription content. 

 MSN Messenger.
1

Send and receive instant messages with your MSN® Messenger 

contacts. 

 Microsoft Windows Media Player for Pocket PC.2 Play audio and video clips on 

your device. Windows Media™ Player lets you play songs and video files that have 

been recorded in the MP3 or WMA formats. 

1 Requires an account with an Internet service provider. 
2 Check the Microsoft Mobile Devices Web site for updates to Windows Media Player, including details on 

support for video file formats and streaming audio and video capabilities.
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 Where to Find Information 

ActiveSync

The ActiveSync Troubleshooter on your desktop PC is on the ActiveSync File menu, 

click Connection Settings, and then click Help. You can install ActiveSync 3.7.1 from the 

provided Companion CD. In case that you lose the companion CD, download and install 

the latest ActiveSync version on www.microsoft.com/mobile/pocketpc/download on your 

desktop PC.  

Using Help on Your Device 
You can get help for specific programs and for Microsoft Pocket PC software by tapping 

Help on the Start menu. Help can be displayed for the active program. To display a 

menu of all Help files available on your device, tap the View menu, and then tap All

Installed Help, or simply tap Help while the Today screen is active. 

Using This Manual 

This User's manual is designed to help you get started using your device quickly and 

easily. Although great care has been taken to ensure the accuracy of procedures and 

artwork, some of the screens displayed on your device may be a little different from the 

ones that appear in this User’s manual.  

This User's manual includes certain visual cues that will help you find the information you 

want easily. 

Notes : Helpful information related to the topic. 

Notice : This is important information that should be observed to prevent loss of 

data or damage to your device. 
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This chapter will help you start using your device. You will become familiar with the hardware 

and learn how to set up your device. When you finish this chapter, you will have all the 

information you need to begin working with your device. 

 This chapter includes step-by-step instructions to help you.  

- Complete the Welcome Wizard 

- Using Today Screen 

- Using File Explorer 

- Power up device 

- Hardware buttons 

- Caring for your device 

Chapter 2

Getting Started
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Complete the Welcome wizard 

Follow the steps in this section to start using your device for the first time or after performing 

hard-reset.

Gently touch the screen with stylus. From 

now on, it is called “tap”. 

A target (+) will move in the order of “center 

 upper left  lower left  lower right 
upper right” on your screen. Since 

calibrating the touch screen has a direct 

affect on the recognition ability of your touch 
screen, be sure to accurately tap the center 

of the target (+) with your stylus. 
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This is the way of how to single-tap and tap and 

hold, tap the Next button. 

Tap and hold this location to have next window. 
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Tap and hold this location next to 11 to paste the 
cut contents. Then you will have the new pop-up 

menu.

It is called “Pop-up” menu. Select Cut.. 
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Select Paste on this list. 

The pasted contents have appeared. Tap the Next 

button.
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Select a time zone you stay from 

the drop-down list box. 

Tap the screen to finish the Welcome wizard. 
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Using Today Screen 

After finishing the Welcome wizard, put your device on the cradle connected to your desktop 

PC to automatically synchronize through Microsoft ActiveSync so that you have the next screen. 

Now, you are ready to enter Owner information. Tap Owner information to have next screen. 

Tap any text box where you want to enter information to have input panel displayed. For more 

Enter your personal information which is not synchronized 
with your desktop PC. 

Start menu 

Select this option box to have your personal 

information displayed whenever you turn on 
your device.

Synchronize today with your desktop PC through 

ActiveSync. Command bar 

Navigation bar 
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detailed information on input panel, see chapter 3. 

For more personal information if needed, select the Notes tab. 

EnglishKorean

Select this option box to have your personal 

information displayed whenever you turn on 

your device. 

Number, special characters 

Tap OK to save the current screen. 
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Volume 

Time 

vibrate : select the vibrate option box. 

diabled : select this option box not to vibrate or 

sound.

Navigation bar 
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Open the recently used program & start the program you want

Open program directly you want from the Todays screen

Navigation Bar

Select the 
recently used 

program you 

want. 

Start menu bar 

Tap the Settings to customize. 

Command Bar 
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Tap OK to save these settings. 

File Explorer 

This File Explorer of your device is similar to Window Explorer of desktop PC.  

Select the Start menu > Programs > File Explorer.

Select to go to the higher level of 

a folder. 

Select a folder below My 

Device you want to move to. 
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View the contents of Mini SD(Secure Digital) card 

Insert Mini SD cards into the Mini SD card slot so that SDMMC Disk folder appears. Tap this 

folder to view the contents of Mini SD card. 

 Make or delete a new folder 

Mini SD Card folder 

My device icon 

Magicn Store folder shortcut  
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Copy and Paste 

Tap and hold the file you cut, copy, rename and delete to have Pop-up menu displayed. Also tap 

and hold out of files or folders to have a little different pop-up menu that includes new folder. Now 

we show you an example of process where we copy a file from a folder and paste it to another folder. 

Tap and hold a file you copy to have Pop-up menu displayed and tap Copy. Select Personal 

you want to paste the copied file to. On the Personal folder, tap and hold the empty space to 

have pop-up menu that includes Paste. 

Tap and hold a file you copy to have Pop-up 

menu displayed and tap Copy. 

This is a pop-up menu 
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Powering up device 

Because the data and files you save on your device are stored in RAM, maintaining a 

continuous power supply to the device at all times is extremely important. If your device runs 

out of power, all information stored in RAM is lost. The preinstalled programs will not be deleted 

even if your device suffers a loss of power; however, any custom settings and programs you 

have added will be erased. 

To safeguard data against loss in the event of power failure, you can save or back up files to NAND Flash 

ROM(called “File Store” here). For more information, see “Backing Up and Restoring Data” in chapter 4 

and “Managing Memory” in chapter 6. 

Your device receives power from two sources: the main battery and the ac power adapter. The 

following sections describe these sources. For tips on extending battery life, see “Managing 

Power” in chapter 6. 

Battery

The lithium-ion battery pack provides power to your device while it is not connected to ac power. 

Actual battery life will vary depending on how you use your device. Some functions, such as 

listening to music, using the backlight, or operating SD cards, use considerable power and may 

reduce this time significantly. 

The battery is charged whenever your device is connected to an ac power source—either the 

AC adapter or the USB cradle. Usually, it takes 5 hours to charge your battery fully depending 

on the battery status. Connect your device to AC power or place it in the cradle when it is not in 

use, to ensure that the battery is fully charged when you need to take it with you. When the 

battery is fully charged, charging stops automatically; the battery will not overcharge even if it is 

left upon being connected to AC power. 

When the battery charge is low, a low battery warning is displayed. If you see a 

low battery warning message, connect to AC power and charge the battery 

immediately to prevent possible data loss. 
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AC Power with Cradle 

To avoid running out of battery power, you can operate your device on AC power using the 

supplied AC adapter. The AC adapter accepts 100 V to 240 V, enabling you to connect to AC 

power anywhere in the world. When you travel, you may need adapters to accommodate 

different electrical outlets, but the AC adapter will safely convert AC voltage to the DC voltage 

required by your device. 

While your device is connected to AC power, the battery is charged automatically. The color of 

the LED indicates the status of the battery:  

Turning device On and Off 

One of the most convenient features of device is “instant on.” With instant on, there is no 

waiting for your device to start up or shut down; you can start working immediately by pressing 

the power button or one of the function keys. 

When you are finished working, turn off your device by pressing the power button. By default, 

your device will turn off automatically after 5 minute of inactivity if it is not connected to an AC 

power source. You can use the Power control panel to change these settings. 

Red indicates that the battery is charging, and blue indicates that the battery is 

fully charged. 

You can use the Power control panel to change these settings. On the Start

menu, tap Settings, tap the System tab, and then tap the Power icon. 

This LED shows you the status of extra battery 

that may be seated on the back of this cradle. 
Red indicates that the battery is charging, and 

blue indicates that the battery is fully charged. 
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Using the Hardware Buttons 

Function Keys 

 ( ) : Calculator 

 ( ) : Notes 

 ( ) : Tasks 

 ( ) : Tab 

 ( ) : Space 

 ( ) : Backspace 

Phone Status LED 

 Phone service area: Green flashing with a period of 20 seconds. 

 No Phone service area: Red on. 

 When sending call signal, your call is connected: Red on. 

 When receiving call signal, bell sound rings: Red on. 

 Receiving SMS message : Scarlet on 

 You have the unread SMS message: Scarlet flashing. 

 Using wireless internet: Blue on when transferring data, red on when receiving data. 

Charging Status LED 

 Blue indicates that the battery is fully charged. 

 Red indicates that the battery is charging. 

 Flashing Red indicates that the temperature of battery is higher than the standard 

temperature. It is recommended to seat your device on the cradle again. 

Navigation Pad 

Use the Navigation Pad to scroll through documents or to highlight items in a list. 
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Caring for Your device

When treated properly, your device will be a reliable personal digital assistant. Follow these tips 

to ensure long and trouble-free use of your device: 

Protect the screen. 

Pressing too hard on the touch screen may damage the screen. Use the stylus to tap the 

device screen to avoid scratches or damage to the screen. To clean the screen, use a small 

amount of commercial glass cleaner sprayed on a soft cloth. Avoid spraying the screen directly. 

Be sure to turn off your device before cleaning the touch screen. If your device is set to power on when 

you tap the screen, change this setting before you clean the touch screen.

Do not drop your device. 

Dropping your device can cause damage to delicate components such as the screen. 

Accidental damage is not covered under the warranty. 

Avoid radiated interference. 

Radiated interference from other electronic equipment may affect the appearance of the display 

of your device. Removing the source of the interference will return the display to normal. 

Avoid high temperatures. 

Your device is designed to operate at temperatures between -20 to 60 ºC (-4 to 140 ºF). Using 

the device at temperatures outside this range may damage the unit or result in loss of data. Be 

especially careful not to leave your device in direct sunlight or in a car where temperatures can 

rise to harmful levels. 
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 In this chapter you have several options for entering new information: 

- Block Recognizer

- Keyboard

- Letter Recognizer

- Transcriber

Chapter 3

Using Input Panel
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Using the Input Panel

Use the Input panel to enter information in any program on your device. You can write 

using keyboard, Block Recognizer, Letter Recognizer, or Transcriber. In any case, the 

characters appear as typed text on the screen.  

To show or hide the Input panel, tap the Input panel button. Tap the arrow next to the 

Input Panel button to see your choice.  

Block Recognizer

 Using Block Recognizer 

1. Tap the arrow next to the Input panel button, and then tap Block Recognizer. 

2. Write a letter in the box. 

When you write a letter, it is converted to typed text that appears on the screen. For 

specific instructions on using Block Recognizer, open Block Recognizer, and then 

tap the question mark next to the writing area.

Punctuation & symbol 

Space

English entry area Number entry area

Return

Back space 

Input Panel for Block Recognizer 
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Keyboard

 To type with the soft keyboard 

1. Tap the arrow next to the Input panel button, and then tap Keyboard. 

2. On the keyboard that is displayed, tap the keys with your stylus. 

Letter Recognizer

Back space 

Return

Space Input Panel for Keyboard 

Back space 

Return

Space

Punctuation & symbol entry 

Number entry areaEnglish upper/lower case entry area 
Input Panel for Letter Recognizer 

Punctuation entry 
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 Using Letter Recognizer 

1. Tap the arrow next to the Input panel button, and then tap Letter Recognizer. 

2. Write a letter in the box. 

When you write a letter, it is converted to typed text that appears on the screen. For 

specific instructions on using Letter Recognizer, open Letter Recognizer and then 

tap the question mark next to the writing area. 

Transcriber

Tap the punctuation & symbol entry button ( ) to have the next window displayed. 

Input Panel for Transcriber 

Arrow 

Take turns selecting .

Settings

How to make strokes 
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Tap the Settings button( ) to have the next window displayed. 

Select the width of pen and see 

sample displayed below 

Add space after entry 

General tab of Settings 

Move the slide to right/left side to select speed 

and quality. 

Move the slide to right/left side to select 

recognition start time. 

Recognizer tab of Settings
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Tap the  button to refer to how to make strokes. 

Tap the  button to have this window displayed. 

With Transcriber you can write anywhere on the screen using the stylus just as you 

would on paper. Unlike Letter Recognizer and Block Recognizer, you can write a 

sentence or more of information; then, you pause and let Transcriber change the written 

characters to typed characters. 

 To type with Transcriber 

1. Tap the arrow next to the Input panel button, and then tap Transcriber.

2. Write anywhere on the screen. 

For specific instructions on using Transcriber, open Transcriber and then tap the 

question mark in the lower-right corner of the screen. 

Selected character

Select one of 3 options according to how often you use 

the selected shape. 

Tap these arrows to see more choices. 
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To get the most from your device, you will want to connect to your desktop or notebook 

PC. This chapter describes how to establish the connection between your device and 

your desktop PC, and how to synchronize and transfer files between your device and 

your desktop (or any PC that has Microsoft ActiveSync installed).  

 In this chapter, you will learn the followings : 

- Install Microsoft ActiveSync and establish a partnership 

- Full Backup & Restore using Backup/Restore of ActiveSync 

- How to install programs using ActiveSync 

- Connecting to Device 

Chapter 4

Connecting to Desktop



User’s Manual  4-2

Install Microsoft ActiveSync and establish a partnership 

Install Microsoft ActiveSync  

This is an explanation on how to install ActiveSync 3.7.1, based on Windows 2000 
Professional, so you may have a little bit different screen on the different OS versions from 

below. 
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To get the most from your device, you have to connect to your desktop or notebook PC. 

Microsoft ActiveSync enables you to synchronize the information on your desktop PC 

with the information on your device.  In addition, you can back up data from your device 

to your desktop PC and restore this data to your device, and copy files between your 

device and desktop PC. Before you begin synchronization, install ActiveSync on your 

desktop PC from the provided Companion CD or download the latest version from 

Microsoft web site www.microsoft.com . By the way, ActiveSync is already installed on 

your device. 

First of all, insert Companion CD into the CD-ROM of your desktop PC and the CD-ROM 

will begin automatically. Then, select Start and select Install ActiveSync 3.5. Just follow 

the Installation Wizard that automatically begins to install ActiveSync 3.5. 

After installation is complete, the ActiveSync Setup Wizard helps you connect your 

device to your desktop PC, establish a partnership so you can synchronize information 

between your device and your desktop computer, and customize your synchronization 

settings.  

This is an explanation on how to install ActiveSync 3.5, based on Windows 2000 

Professional, so you may have a little bit different screen on the different OS versions 

from below. 
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Select Run this program from its current location to install without saving. 

Click Yes to move to the next screen. 

Click Next. 

Click Next. 

When the process becomes 100%, automatically it will go to the next screen. 
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Connect USB port to desktop PC and the power cable to cradle. Then seat your device 

into USB cradle. 

A wizard of finding a new hardware will begin automatically as below. 

Click Next. 
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Click Next. 

Select CD-ROM drive and click Next. 

Click Next. 
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Click Finish and automatically the synchronization process will begin. And then the 

following processes will appear on your desktop PC. 

Instead of synchronizing, you may set up your device as guest. Even though a guest, 

you may transfer files and data between your device and your desktop PC. 

When you perform hard reset or re-establish a new partnership after deleting the existing 

partnership, you can select one of the options. 

A desktop PC can establish partnerships with several devices while one device can 

establish partnerships with up to two desktop PCs. However, you cannot synchronize 

two devices with one desktop PC at the same time. 

Click Next. 

Select any items you want to synchronize 
and otherwise, deselect the others. 

When it is in a state of Guest, find files 
you want by pressing the Explore button 

of toolbar. 

Now, you are ready to synchronize 
between your device and desktop PC, it 

may take a little long time to finish 

synchronization. 
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Click Next. 

Click Finish. Now, you are ready to establish a new partnership.  

You will have the Microsoft ActiveSync screen as shown below. 

When you perform hard reset on your device, you need to change the partnership name 

that is preset as Pocket_PC. (for example : Pocket_PC1, Pocket_PC2, Pocket_PC3, 

Pocket_PC4)

When you have some difficulties synchronizing your device with your desktop PC, click 

the Connection Settings on the File menu to have the Connection Settings screen 

displayed as below. 

This is the partnership name that is 
established with your desktop PC through 

ActiveSync.

These are the items you have selected for 

synchronizing with desktop PC. 
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Synchronizing Data 

Synchronization compares the data on your device with your desktop PC and updates both 

computers with the most recent information. For example, you can synchronize Microsoft 

Word and Microsoft Excel files between your device and desktop PC. Your files are 

automatically converted to the correct format. And you can synchronize e-mail messages in 

Inbox on your device with e-mail messages in Microsoft Outlook on your desktop PC. And 

you can keep your Pocket Outlook Contacts, Calendar, and Tasks databases up-to-dated by 

synchronizing your device with Microsoft Outlook data on your desktop PC. Use the 

ActiveSync options to select which information should be synchronized and to control how 

much data is synchronized. By default, ActiveSync does not automatically synchronize all 

types of information. 

Tap Settings to customize the selected 
item.
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Select Calendar and click the Settings button. 

Select Contacts and click the Settings button. 

Select any option you want to customize 

Pocket Calendar during the synchronizations. 

Select any option you want to customize 
Pocket Contacts during the synchronizations. 
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Select Tasks and click the Settings button. 

Select Favorites and click the Settings button. 

Select Files and click the Settings button. 

Select any option you want to customize 

Pocket Tasks during the synchronizations.  

This is the folder that includes the file 

synchronized with your desktop PC. You 

will find the Shortcut to the Files 
icon(    )on your desktop PC. 
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Select Inbox and click the Settings button. 

After you customized ActiveSync and completed the first synchronization, you can control 

when synchronization occurs by selecting a synchronization mode.

You have to select the folder you have 

made to be synchronized in the Inbox 

program.

In this example, while synchronizing, it is 

set as copy at most 100 lines to save 
space, copy messages from the last 5 

days. 

Select one of the 3 options: continuously 

while the device is connected, only upon 
connection and manually.
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Copy, Paste and transfer files 

Select the file(s) you want to copy and select Copy on the Edit menu or select Copy on the 

pop-up menu. For pasting file(s), select the Explore button on the Microsoft ActiveSync 

screen of your desktop PC to have the Mobile Device screen displayed as below : 

First, select the folder you want to paste and select Paste on the Edit menu or select Paste 

on the pop-up menu.  

However, when you transfer file(s) between desktop PC and your device, files created on 

your desktop PC may automatically need to be converted before you can use them on your 

device, and also files created on your device may automatically need to be converted before 

you can use them on your desktop PC. However, when you work with software such as 

ClearVue Presentations or ClearVue Image, files should not be converted to the different 

format. In other words, those software use the format identical to the corresponding 

software of your desktop PC. That’s why we need to change the settings of converting 

file format when files don’t need to be converted before you can use them on your 

device.  

You can change the settings as follows :

Tap the Conversion Settings to change 
the options for conversion between 

desktop PC and your device while 

copying, pasting and synchronizing.  
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Select Conversion Settings. 

Deselect this option box not to change the 

file format.  
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Full Backup & Restore using Backup/Restore of ActiveSync 

You can back up files, database, PIM data and programs installed in RAM to your 

desktop PC using Microsoft ActiveSync, and restore them when needed. 

Backup can either be performed automatically when your device is connected to your 

desktop PC, or manually whenever needed. Also, you can back up updated or new data 

only or choose to back up all data. 

Backup

1. Connect your device to desktop PC. 

2. Tap Backup/Restore on the Tools menu of the ActiveSync screen. 

3. Select “Full backup” or “Incremental backup” according to your needs. 

4. You may need the backup file name and the folder when restoring your backup file. 

Tap the Change button to confirm the folder. 

5. Tap the Back Up Now button to begin. 

Tap Back Up Now to begin.  

Tap Change to change backup 
name.

Full backup 

Incremental backup. 

Automatic backup is only possible when a Partnership is established with a 

desktop PC. Only a manual backup is possible when the partnership is 

established as Guest. For more information on Backup/Restoring to and from a 

desktop PC, see Microsoft ActiveSync Help. 
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Restore 

1. Connect your device to desktop PC. 

2. Close all programs running on your device. 

3. Establish a partnership as Guest. 

4. Tap Backup/Restore on the Tools menu of the ActiveSync screen, and select the 

Restore tab. 

Do not remove your device from the cradle or disconnect the USB cable during 

backup.

As newly installed programs or new files created on your device since your last 

backup will be lost after restore, you should move them to your desktop PC or to 

File Store (NAND Flash memory) before you restore data.  

Select this options box to set 

up your device as guest. 
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5. Tap the Restore Now button. 

6. Select the backup file you want to restore and select OK to begin. 

7. Click Restore to begin the restore process. 

8. When completed, perform soft Reset on your device with your stylus and seat your 

device on your cradle to synchronize. 
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How to install programs using ActiveSync 

Using Setup.exe or Install.exe 

1. Download the program to your desktop computer (or insert the CD or disk that 

contains the program into your desktop computer). 

2. Connect your device to your desktop PC. 

3. If the program includes an installer program (typically named Setup.exe or Install.exe), 

double-click the installer program on the desktop PC. The installer program copies the 

necessary files to your device.  

Using cabinet (*.cab) file 

1. Download the program to your desktop computer (or insert the CD or disk that 

contains the program into your desktop computer). 

2. Connect your device to your desktop PC. 

3. Use the ActiveSync Explore button to copy the cabinet (*.cab) file to the Program Files 

folder on your device, and then double-tap the icon on your device to install the program. 

4. Refer to the Read Me file or documentation that came with the program to be sure you 

have copied the necessary file(s). For more information on copying files using 

ActiveSync, see ActiveSync Help. 



Chapter 4  Connecting to Desktop PC  4-19

Connecting to Device

Connecting by USB Cradle 

Using the USB cradle, you can charge and synchronize your device at the same time 

even though the charging circuit is not included on your cradle.  

Keep your device in the cradle when you are not carrying it with you, so it is always 

charged, synchronized, and ready to go. 

Turn off your device or remove it from the cradle before you shut down your desktop PC. 

When you remove your device from the cradle, hold the cradle with one hand, and gently lift 

your device with the other to avoid putting stress on the connectors. 

1. Connect your device to your desktop PC as below: 

2.  How to use the Infrared port of your device: 

The infrared port on your device provides a convenient way to connect to an IrDA-equipped 

PC without using a cable or cradle. Many notebook computers have built-in infrared ports; 

however, you may need to install and configure an infrared port on a desktop PC. To install 

the port, follow the manufacturers instructions. 

Before you connect, be sure of the following: your desktop PC is on, you have 

installed ActiveSync on your desktop PC, and ActiveSync is configured to allow a 

USB connection. 

Windows 95 and Windows NT® do not support USB or infrared connectivity. 
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In addition to connecting your device to your desktop PC, you may want to connect to 

remote computers so you can access e-mail, browse the Internet, or retrieve files from a 

corporate network, whether you are at home or on the road. 

To start the connection, simply open a program that requires a connection to the 

Internet. Your device will attempt to connect automatically.

 Visit Internet or intranet Web or WAP pages by using Pocket Internet Explorer. 

 Send and receive e-mail messages by using Inbox. Before you can use Inbox, you 

need to provide the information it needs to communicate with the e-mail server.  

 Send and receive instant messages with MSN Messenger. For more information, see 

“MSN Messenger” in chapter 9. 

This chapter describes

 browsing the Web using Microsoft Pocket Internet Explorer and Mobile Favorites 

 sending and receiving e-mail messages 

Chapter 5

Using the Internet & E-mail



User’s Manual  5-2

 Browsing the Web on your device 

You have to set up the Internet Settings before you use the Internet Explorer for the first 

time. For more information, refer to the Internet Settings section later in Chapter 6. 

Once you are connected to an ISP or to a network, you can browse the Internet or a 

corporate intranet. You can also use Pocket Internet Explorer to browse Web and WAP 

content while you are not connected—by downloading mobile favorites and channels to 

your device. 

Using Microsoft Pocket Internet Explorer 

Use Microsoft Pocket Internet Explorer to view Web pages in either of these ways:

 Connect to an ISP or network and browse the Web. To do this, you will need to 

create the connection first. 

 During synchronization with your desktop PC, download mobile favorites that are 

stored in the Mobile Favorites subfolder in Internet Explorer on the desktop PC. 

While you are connected to an ISP or network, you can also download files and 

programs from the Internet or an intranet. 

To start Pocket Internet Explorer 

1. On the Start menu, tap Internet Explorer. 

Mobile Favorites button 

Home button 

Refresh button

This device cannot be connected to another computer or laptop and used as an 

external modem to gain access to the Internet or email. 

Access to the Internet is through using the built-in 1xRTT modem in this device. 
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2. On the View menu, tap Address Bar. 

3. Enter address you want on the address bar located on the top of screen and tap the 

arrow next to the address bar, then it will automatically connect to the Internet using 

CDMA module. 

4. When the internet connection is completed, the internet connect (  ) icon will 

appear on the Navigation bar. 

5. When you want to finish using Internet, tap the stop ( ) button on the Command bar 

so that you have the Internet browse( ) icon stopped. And also you need to tap X on 

the right-upper corner and tap the Internet connect ( ) icon and tab the End button on 

the Connected pop-up screen to stop your Internet connection completely. 
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Mobile Favorites folder 

Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet 

Explorer on your desktop PC will be synchronized with your device. This folder is created 

automatically when you install ActiveSync. 

You can only view the mobile favorites offline that was synchronized with your desktop 

PC. If the page is not synchronized with your desktop PC, it will be dimmed in the 

Favorites list of your device. You will need to synchronize with your desktop PC again to 

download the page to your device, or connect to the Internet to view the page. 

To make Mobile Favorites 

1. Select Options on the Tools menu or click the Options button to have the Options 

screen displayed. Then select the Favorites check box and click OK. 

2. Select Create Mobile Favorites on the Tools menu of Microsoft Internet Explorer of 

your desktop PC.  

3. When you select OK, the Internet Explorer will download the latest version of the 

corresponding page. Then you will find the icon( ) on the task tray bar of your desktop 

PC.
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To make the Mobile Favorites button on the Tools menu of 

your desktop PC 

Select Tools bar > Customize on the View menu of Microsoft Internet Explorer to add the 

Mobile Favorites button on the Tools bar. 

Select Create Mobile Favorites on your left pane and click the Add button to send that 

item you select to the right pane as described above. Then you will find the Mobile 

Favorites( ) button on your tools bar of your Microsoft Internet Explorer. 

To reduce the amount of memory caused by Mobile Favorites 

Mobile favorites take up storage memory on your device. Follow these tips to minimize 

the amount of memory used: 

 Use ActiveSync settings to turn off pictures and sounds for the Mobile Favorites or to 

stop some mobile favorites from being downloaded to your device. For more 

information, see ActiveSync Help.

1. Select Options on the Tools menu or click the Options button to have the Options 

screen displayed.  



User’s Manual  5-6

2. Then select the Favorites check box and click the Settings button. 

3. Deselect pictures and sounds for the Mobile Favorites and click OK. 

To view Mobile Favorites offline 

1. Tap the Favorites button on Pocket Internet Explorer of your device to display your list 

of favorites.  

2. In the list, tap the page you want to view. 

Tap the favorite you want to view. 

Tap to add or delete a folder or favorite link. 
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 Sending and Receiving E-mail 

If you have an e-mail account with an ISP or on a corporate network, you can use Inbox 

to send and receive e-mail messages in two ways: 

 Synchronize e-mail messages with Microsoft Outlook on your desktop PC. 

 Send and receive e-mail messages by connecting directly to an e-mail server 

through an ISP or a network. 

Synchronizing E-mail Messages 

You can synchronize e-mail messages as part of the general synchronization process 

whenever you connect your device to your desktop PC. First, you must enable Inbox 

synchronization in ActiveSync. 

Select the Options button on the Microsoft ActiveSync screen. 

Select Inbox and click the Settings button. 
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Make selections as you want and click OK to copy the Inbox folder of your desktop PC to 

the Inbox folder of your device. 

Here is the list of mail messages after you synchronize through ActiveSync. 

 This is unread message. 

 This is unread message with attachments that need to be downloaded. 

 This is already read message. 

 This is read message with attachments that is already downloaded. 

Select the folders you want to synchronize. 

Shows you this is a read mail message. 

Shows you this is a mail message with attachments 
that need to be downloaded. 
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If you want to download the attachments, tap and hold the corresponding message to 

have pop-up menu displayed. Then select Mark for Download. 

Then this  icon will be changed to .

Using the Message List

Messages you receive are displayed in the message list. By default, the most recently 

received messages are displayed first in the list. 

Select the sort order for messages. 

Tap to connect and to send and receive e-mail. 

Tap to connect to the 

selected service. 
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When you receive a message, tap it to open it. 

You can mark the messages that you want to retrieve in full during your next 

synchronization. In the message list, tap and hold the message you want to retrieve. On 

the pop-up menu, tap Mark for Download. The icons in the Inbox message list give you 

visual indications of message status. 

Make a new message 

1. Tap New.

Tap to show or hide the complete header.

Tap to show / hide the recording toolbar.

Tap to display the Address Book.

Tap to return to the message list. 

Tap to delete this message. 

Tap to view the previous or next message. 

Tap to reply to or forward this message. 

When you select this message with attachments that 
is already downloaded, the message will open with 

attachments displayed on the bottom of screen. 

Tap to send the message.

Tap to insert common 

messages.
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2. In the To field, enter an e-mail address of one or more recipients, separating them 

with a semicolon, or select a name from the contact list by tapping the Contacts 

button.

3. Compose your message. To enter preset or frequently used messages, tap My Text 

and select a message. 

4. When you have finished the message, tap Send.
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Delete a message 

When your device is synchronized with your desktop PC, and when you want to delete a 

message on your device, tap and hold the message to have pop-up menu displayed. 

Then select Delete. 

If your device is not synchronized with your device, the next time your device is 

synchronized, the corresponding message on your desktop PC will be deleted. 

Reply, Reply all or Forward a message 

When you want to reply, reply all or forward a message on your device, tap and hold the 

message to have pop-up menu displayed. Then select Reply, Reply all or Forward. 
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Connecting Directly to an E-mail Server 

In addition to synchronizing e-mail messages with your desktop PC, you can send and 

receive e-mail messages by Inbox on your device using CDMA module.  

The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway. 

Customize a new mail service 

You can use multiple e-mail services to receive your messages. For each email service 

you intend to use, first set up and name the e-mail service. If you use the same service 

to connect to different mailboxes, set up a separate service for each mailbox.  

In Inbox, tap Accounts, and then tap New Account. Follow the directions in the New 

Service Wizard. Here is just parts of setting a wizard. 

Enter e-mail address and tap Next. 
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After the status becomes Completed as shown above, tap Next. 

Enter your name and password and then tap Next. 

Select POP3 or IMAP4 if it is supported, 

enter a name in the Name box (for 
example, My Mail).
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To connect to an e-mail service 

In Inbox, tap Services, and then tap Connect. Then through CDMA module, you will be 

connected to mail server. Messages in your own local folder will be downloaded from this 

mail server directly. 

Enter server names in the Incoming mail 

box and the Outgoing mail box(for example, 

mail.bigpond.com), and if needed, tap 
Options to set the other options. For more 

detailed information, ask your the network 

administrator or corporate mail-server 
administrator. 
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To synchronize your own local folder through ActiveSync 

If you want to synchronize your own local folder through ActiveSync, select the local 

folder(for example, POP3 as shown below) and on the Tools menu, select Manage 

Folders.  

Select the subfolder you want to synchronize through ActiveSync and tap OK on the 

upper-right corner. 

By default, each mail service is composed of 5 subfolders. 

 Inbox 

 Outbox 

 Sent Items 

 Deleted Items 

 Drafts 

When you connect to the e-mail server, new messages are downloaded to the Inbox 

folder on your device, messages in the Outbox folder are sent, and messages that have 

been deleted on the e-mail server are removed from the Inbox folder on your device. 

You can work online or offline. When working online, you read and respond to messages 

while connected to the e-mail server. Messages are sent as soon as you tap Send, 

which saves space on your device. 

When working offline, you should download new message headers or partial messages, 

and then you can disconnect from the e-mail server while you decide which messages to 

download completely. The next time you connect, Inbox downloads any messages you 

marked for retrieval and sends the messages in your Outbox folder. 
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To download the attachments of message 

You can download the attachments of message through directly connecting to mail 

server using the CDMA module. 

Tap the Connect ( ) icon to directly connect to the mail server. 

Then you will find the connect  icon on the navigation bar. 

Tap the connect  icon on the navigation bar to finish this connection. 

Tap and hold the message to download the attachments and select Mark for Download 

on the pop-up menu. 
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This chapter details ways you can optimize your device using the Settings, and 

describes ways you can expand features and functionality by adding programs.  

- Settings 

Chapter 6

Configuring Device
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Settings

On the Start menu, tap Settings.  You will see 3 tabs: Personal, System and 

Connections.  

1. the Personal tab 

Tap the Buttons (    ) icon to assign functions to the 4 buttons located on the front of 

your device. You can assign some functions to the hardware buttons using this setting. 

First, select a button among the 4 buttons 

and select a program you want for that 
button on the assignment. 
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Move the slide to adjust the delay before 
first repeat. 

Move the slide to adjust the repeat rate. 



User’s Manual  6-4

Tap the Input (     ) icon to adjust a setting on the Input Panel. 

It is recommended that you select the 

default mode of voice recording format to 

conserve your memory size. 

Select the default mode among Block 

Recognizer, keyboard, Letter Recognizer, 

Phone Dialer and Transcriber. 
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Tap the Menu (     ) icon to adjust the programs listed on the Start menu and New 

menu.

Selected items appear in the Start 

menu. Otherwise, the rest appear in 

Programs.

Select the Turn on New button menu 

item to have the selected items 

displayed on the New menu list. 
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Select this option box to show this 

information when device is turned on. 
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Tap the Password (     ) icon to change a password. 

When you select the Strong alphanumeric 
password item, you have to enter the 7-digit 

password: a combination of the English upper 

case and lower case letters. 
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Tap the Sounds & Notifications (    ) icon to adjust sounds that is enabled for events, 

programs, screen taps and hardware buttons. 

According to each event, select the 

corresponding sounds or 

notifications.
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Tap the Today (      ) icon to use an image file as the background and select programs 

that appear on the Today screen. 
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2. the System tab 

Tap the About (      ) icon to see the version and copyright. 
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While synchronized, this will be used 
for identifying itself and establishing 

a partnership.
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Tap the Backlight (     ) icon to adjust the backlight. 

It is recommended to conserve your 

battery life that you turn off backlight 

if device is not used for the time you 
select here. 
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Tap the Certificates icon to adjust the backlight. 
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Tap the Clock (     ) icon to adjust the current time and alarms. 

Select the right one according to where 
you stay. 
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 Tap the Memory (     ) icon to adjust the allocation of memory temporarily. 

To conserve the program memory, you can 

stop programs that are not being used. 
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Tap the Power (     ) icon to see the state of battery. 

While being 
seated on cradle, 

if main battery is 

not fully charged, 
it will move from 0 

to 100% on the 

charging bar 
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Tap the Regional Settings (    ) icon to adjust the time, number, especially period, 

money and data type. 

Select where you stay. 
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Tap the Remove Programs (     ) icon to remove the programs that are installed on 

your device. 

When the storage memory is 

short, remove the program 
installed on your device. 
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Tap the Screen (     ) icon to adjust the touch screen if your device is not responding 

accurately to screen taps. 

Press down the up button of the navigation key and press the power button at the 
same time to have the Align Screen displayed.
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Tap the System icon to see system information and adjust the wake up, USB and GPS. 
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3. the Connections tab 

Tap the Beam (     ) icon to adjust the beam settings of your device. 
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Tap the Connections (      ) icon to set the options for a modem connection. 
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Your device has a built-in CDMA module that supports wide-range data communication 

and additional features including SMS (Short Message Services), along with voice calls. 

These features save you the trouble of having to purchase another cellular phone with a 

phone number. Remember that you have no other right to copy the ESN number against 

the communication law.  

This chapter includes information on:

 Phone Program  

 SMS : Short Message Service  

Chapter 7

Using the Mobile Phone
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Phone Program 

This phone program enables you to place a call. 

Use the dial pad to enter the phone number and tap the Send button. 

The Phone display 

Indicators in the Phone display 

Indicators Description Indicators Description 

 Signal Intensity  Vibrate mode 

 Service area  1x network 

 Not in service area  95A network 

 Lock  Roaming 

 Voice message or SMS  Battery charging status 

Short Message Service

Note

Call

Send button

Clear button

End button

Recently Dialed Phone display

ContactsSettings

You can communicate with other persons through the speaker and microphone 

and the optional earphone that should be inserted into earphone jack. 

Display Own Number and Version 
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Using the NOTE button 

Here is how we can use the NOTE button during a voice call.  

When you need to make a note during a voice call, tap the NOTE button to open the note program that is 

provided on your phone program. You can enter any contents you want and record your voice. 

When you finish entering any contents you want, tap the      button to display the folder(File 

Store\CallNotes).
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Using the CALL button 

Tap the Call button to display a list of recently incoming, outgoing and missed calls, 

including caller information and call time since initializing your phone.  

Select the item that is displayed as No Name and tap the Save button to save a corresponding name. 

Add the corresponding name for it and tap OK. 

Tap to save to Contacts

Three-way calling

Call waiting

Missed call

Outgoing call
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Using the SEND button 

You can make a call as follows : 

 Enter phone number and tap the SEND button to make a call.  

 When you tap the SEND button shortly once, the number you last called 

appears on the screen and if you tap this button once more, you are connected 

to this number.  

 You can use the up/down control to have the recently dialed numbers displayed. 

When you press the up button or down button of the up/down control, the 

number you last called appears on the screen. If you press the Enter button, 

you are connected to this number. 

Using the CLEAR button 

If a mistake is made while dialing, tap the Clear button to clear the last digit, or tap and 

hold the Clear button to clear all the digits. 

Using the END button 

Tap the END button to end a call.  

Tap and hold the END button for a little longer (2 or 3 seconds) to turn the CDMA 

module off so that you cannot make a call, send SMS messages and browse the Internet. 

Tap and hold the END button again for a little longer (2 or 3 seconds) to turn the CDMA 

module on. 

Using the Vibrate mode 

Tap and hold the icon on the dial pad to turn the Vibrate mode on. Then you will be 

able to feel vibrating on your device and also see the icon on the Phone status pane. 

On this Vibrate mode, you will feel the vibration on your device when a call is coming.  

Using the Lock button 

Tap and hold the icon on the dial pad to turn the Lock mode on. Then you will be 

able to see the icon on the Phone status pane. You cannot make any calls on the 

Lock mode. When you want to get out of the Lock mode temporarily, enter the password 

on your dial pad. Turn your phone program off and on to go back to the Lock mode. If 

you want to get out of the Lock mode permanently (in stead of temporarily), tap and hold 

the Lock button to have the password screen displayed. Then enter the password that is 

set as “0000”.  

You can not make a call, browse the Internet and send SMS messages while the 

CDMA module is not on. 
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Placing a call 

You can place a call as follows : 

 Use the dial pad to enter the phone number, including the area code and tap 

the Send button. 

 When you want to use the Contacts to place a call, tap the Contacts icon on the 

Command bar. 

Select a phone number you want and tap the Dial button on the upper-right 

corner. You will see only one phone number for each person at this screen. If 

you want to place a call with another phone number, double-tap the 

corresponding contact to display the screen as below: 

Tap a phone number you want to place a call automatically. 
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 Use speed dial numbers to place a call as follows: 

 One-digit number (0 ~ 9): Tap and hold (about 2 seconds) the 

corresponding speed dial number. 

 Two-digit number (10 ~ 99): tap the first digit of the speed dial number, 

and then tap and hold the second digit of the speed dial number. 

 Or tap the corresponding speed dial and tap the Send button. 

If you don’t remember the corresponding speed dial, tap the Settings icon on 

the Command bar > the User button and select the Speed dial icon. 

Select the speed dial you want and tap the Dial button. 
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To receive a call 

When the incoming call is alerted with a flashing indicator and an audible sound or a 

vibrating alert with the screen displayed as follows:  

Tap the ANSWER button to receive this call, or tap the MUTE button when you don’t 

want to hear the bell sound (but the caller can still hear the outgoing bell sound) or tap 

the IGNORE button to disconnect the call without answer. 

While communicating through your phone module, you will also see icons on the Command bar as follows:  

Icons Descriptions 

Mute

Un-mute

Tap one icon to have the other icon displayed. 

You can un-mute while communicating. 

Key Sound 

Remove Key Sound 

Tap icon to have the other icon displayed. 

You cannot hear any key sound while tapping any key on your dial 

pad.

User Information 
Tap this icon to have the User Information screen displayed and you 

can select any number you have entered before to send out. 
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Make a speed dial using Contacts 

Tap the Contacts icon on the Command bar.  

Double-tap a contact you want to make a speed dial for.  

Tap the Speed dial button. 

Tap to assign a specific bell sound to the 

specific person. 
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Tap the arrow to select a phone number that is saved for the specific person.  

Select the phone number you want and select speed dial number on the list as shown below. 

Tap the Add button to add this number to the Speed Dial list 

Tap the arrow to select a phone number 
that is saved for the specific person and 

enter the speed dial number and tap the 

Add button. 

If you have too many speed dial 

numbers, you can use these buttons as 

shortcut buttons. 
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Add your picture to contact 

Copy a picture (100*100 pixel, BMP file recommended) to a folder you want through 

Microsoft ActiveSync. 

Tap the Contacts icon on the Command bar. 

Double-tap a contact you want. 

Tap the Picture button. 
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Select the folder you want and tap the picture. 

Call Waiting 

When you are on the phone and another call is received, you hear a call waiting tone 

and you will have the next screen on the display. 

Select any person you want to communicate. 

Tap OK to enter a numeric digit on the 
main screen of phone program. 

However, you are still on the Call Waiting 

mode.
On the main screen of the phone 

program, you can try as follows : 

Press the 1 button and the Send button 
to disconnect the original caller and 

switch to another caller. 

Press the 2 button and the Send button 
to switch to another caller. 

Press the 3 button and the Send button 

to move to the conference call mode. 

Tap to end all calls. 



Chapter 7 Using the Mobile Phone  7-13

Using the Settings button 

Tap the Settings ( ) icon to adjust the settings on the phone program. Tap the User 

Settings button to display the User Settings screen. 

Tap the Lock ( ) icon to adjust the settings on restricting calls including the 

international call, Call Log and SMS. 

Control Panel Settings User Settings 

This enables you to restrict these 

functions: international call, call log, 
SMS.
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Tap the Ring Setting ( ) icon to display the sound screen. 

Tap the SMS settings ( ) icon to display the SMS settings screen. 

Select the bell sound or adjust the 
volume. Also you can download the 

bell and install it for your favorite bell 

sound.

Select the option of how your device 

let you know that SMS arrives. 
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Tap the Ear-Set ( ) icon to adjust the setting on headphone. 

Tap the Data Communiation ( ) icon to adjust the setting on how you close the 

connection to avoid unnecessary charging after using data communication. 

It is recommended that you set up 

the option to avoid unnecessary 

charging after using data 
communication. 
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Tap the Phone Initialization ( ) icon to initialize your phone program. 

Tap the Password ( ) icon to change your password. 

Select the items you want to 
Initialize and tap the OK button. 

As default, your password is “0000”, 

but when you want to change to 
another number your want, use this 

setting. And also be sure to 

remember your new password. 
Otherwise, you have to ask A/S 

center to repair. 

Your password should be 4 digit number. 
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Tap the Auto Answer ( ) icon to automatically answer an incoming call after a few 

rings without any key press. 

Tap the DTMF Tone( ) icon to change the DTMF tone. 

Select Long DTMF when you want 

the key-pressing tone to sound long, 
and select Short DTMF when you 

want the key-pressing tone to sound 

short, regardless of how long you 
press the key. 
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Tap the Change SKIN ( ) icon to change the skin. 

Tap the Voice Privacy ( ) icon to make Voice Privacy available during a call. 

First, save your skin to a folder you 
want, then your phone program skin 

will be displayed. 

Tap Enhanced to make Voice 
Privacy available during a call. 
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Tap the Voice mail ( ) icon to adjust the settings of voice mail. 

Tap the Call Forward ( ) icon to adjust the settings of call forward. 

First, ask your service provider of 

how you register for this service and 

tap the register button to register. To 

hear the voice mail that arrived while 

you could not receive them, tap the 

Connect button.  

Enables you to reroute incoming 

calls to a different phone number 

when it is registered. For information 
on registration, ask your service 

provider.  



User’s Manual  7-20

Tap the Call Waiting ( ) icon to adjust the settings of call waiting. 

Tap the Recent Outgoing ( ) icon to delete or see the recently sent messages. 

Double-tap the number you want to 

make a call to.  

Select an item you want to delete 
and tap the Delete button. 

Be careful not to tap the Delete All 

button mistakenly. 
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Tap the Emergency Calls ( ) icon to see emergency calls on the list. 

Enables you to add, modify and 
delete emergency numbers. Double-

tap a number you want to make a 

call.
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Tap the Speed dial ( ) icon to see a speed dial for the number you use frequently. 

Tap the Convenience ( ) icon to reset your calls including voice and Internet. 

Select a speed dial added before for 

your convenience number to make a 

call.

Enables you to reset your past voice 

calls and Internet. 
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Tap the WMP Control ( ) icon to adjust the settings of Windows Media Player. 

Tap the Data Backup ( ) icon to perform the data backup. 
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SMS(Short Message Service) 

Contact your service provider before using this function. 

Tap the SMS button on the phone program to display the SMS message screen. When 

you receive a SMS message, appears on the phone status pane of the phone 

program. When you tap this icon on the phone status pane of the phone program, 

nothing happens and you have to tap the SMS button on the right side of the phone 

program. 

Tap a message you want to open. 

: Unread message 

: Read message 

: Duplicated message 

Tap the Delete All button to delete all 

messages listed above. So be careful 

not to delete all messages mistakenly. 

Tap to save sender’s information on 

your contacts. 

Tap to make a new SMS message. 

Tap to reply to the selected message. 

Tap to open the list of SMS Inbox. 

Tap to open the list of SMS Outbox.

Tap to open the list of SMS Temporary folder. 
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Add sender’s phone number to your contacts 

Tap the SMS button on the right side of the phone program. 

Among the SMS messages listed on the Inbox tab, if there are messages whose phone 

number you want to add to your contacts, select the message and tap the Save Contacts 

button to save the phone number to Contacts. 

Enter any necessary information and tap OK. 
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Reply to and Forward SMS  

Among the messages listed on the Inbox, select a message you want to reply to. 

Tap the Reply button 

Tap the Contacts button or tap the Enter Phone Number box to enter phone number you 

want directly.  

Enter messages on the text box and tap the Send button to send the message. 

When you enter several phone numbers on the Enter Phone Number box, each 

phone number should be separated by semicolon (;). 

Tap to enter the call back. 

Tap to temporarily save this message 
to the temporary folder. 

Double-tap to forward this message. 
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Compose a new message  

Tap the New button of each view. (Inbox, Outbox and Temp of SMS) 

Tap the Contacts button or tap the Enter Phone Number box to enter phone number you 

want directly.  

Enter messages on the text box and tap the Send button to send the message. 

Tap to enter the call back. 

Tap to temporarily save this message 

to the temporary folder. 

When you enter several phone numbers on the Enter Phone Number box, each 

phone number should be separated by semicolon (;). 

The length of a text message that you can send each time varies slightly from 

each service provider, but it is mainly limited to approximately 80 characters for 

English. Therefore, if the message you have created surpasses the limit, it will 

be divided into 80 characters. The number of messages to be sent is 

automatically displayed on the bottom part of the New window. 
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Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You 

can use these programs individually or together. For example, e-mail addresses stored 

in Contacts can be used to address e-mail messages in Inbox. 

Using ActiveSync, you can synchronize information in Microsoft Outlook on your desktop 

PC with information in Pocket Outlook on your device. Each time you synchronize, 

ActiveSync compares the changes you made on your device and desktop PC and 

updates both computers with the latest information. For information on using ActiveSync, 

see ActiveSync Help on your desktop PC. 

In this chapter, you will learn to

 Schedule appointments and meetings using Calendar. 

 Keep track of friends and colleagues using Contacts. 

 Keep a to-do list in Tasks. 

 Capture thoughts and ideas with Notes. 

For details on using Inbox to send and receive e-mail messages, see “Sending and 

Receiving E-mail” in chapter 5. 

Chapter 8

Microsoft Pocket Outlook
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Calendar : Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events. You can 

check your appointments in one of several views (Agenda, Day, Week, Month, and Year) 

and easily switch views by using the View menu. 

When you select landscape on the settings you will have a screen as follows :  

(If you want to select “landscape”,  > “Settings” > “System” tab > “Screen ”  icon. 

For more detailed information, see the screen setting on chapter 6 Configuring Device.)

For description below, portrait screens are used. 

You can customize the Calendar display (for example, change the first day of the week), 

by tapping Options on the Tools menu. 

Tap to go to today.

Tap to create a new 
appointment.

Agenda view 

Day view 

Week view 

Month view 

Year view 
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 Reminder  Recurs    Note 

 Location  Attendees  Private
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To create an appointment 

1. In Day or Week view, tap the desired date and time for the appointment. 

2. Tap New.

3. Using the Input panel, tap first to select the field, and then enter a description and a 

location.

4. If needed, tap the date and time to change them. 

For example, select the date to have the calendar pane displayed as below. 

5. Enter other desired information. You will need to hide the Input panel to see all 

Tap to choose from predefined text. 

Tap to choose from previously entered locations. 

Tap to return to the calendar (the 
appointment is saved automatically).

Tap to select a time. 
Tap to select a date. 

The Notes tab is a good place for maps 
and directions. 
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available fields. 

6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For 

more information on creating notes, see “Notes: Capturing Thoughts and Ideas,” 

later in this chapter. 

7. Tap OK to return to Calendar. 

If you select Remind me in an appointment, your device will remind you according to the 

options set in the Sounds & Notifications control panel. 

Using the Summary Screen 

When you tap an appointment in Calendar, a summary screen is displayed. To change 

the appointment, tap Edit.

Tap to change appointment. 
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Creating Meeting Requests 

You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The 

meeting notices will be created automatically and sent either when you synchronize 

Inbox or when you connect to your e-mail server. 

Indicate how you want meeting requests sent by tapping Tools and then Options.  

If you send and receive e-mail messages through ActiveSync, select ActiveSync. 

To schedule a meeting

1. Create an appointment. 

2. In the appointment details, hide the Input panel, and then tap Attendees.

3. From the list of e-mail addresses in Contacts, select the meeting attendees. 

Tap to show Input Panel. 

 Reminder  Recurs    Note 

 Location  Attendees  Private
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The meeting notice is created automatically and placed in the Outbox folder. 

For more information on sending and receiving meeting requests, see Calendar Help 

and Inbox Help on your device. 
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Contacts: Tracking Friends and Colleagues

Contacts maintains a list of your friends and colleagues so that you can easily find the 

information you are looking for, whether you are at home or on the road. Using the 

infrared port of your device, you can quickly share Contacts information with users of 

Pocket PCs and other mobile devices. 

When you select landscape on the settings you will have a screen as follows :  

(If you want to select “landscape”,  > “Settings” > “System” tab > “Screen ”  icon. 

For more detailed information, see the screen setting on chapter 6 Configuring Device.)

For description below, portrait screens are used. 

Tap and enter part of a name to quickly 
find it in the list. 

Select the category of contacts you want displayed in the list. 

Tap to display or edit the contact details. 

Tap and hold to display a pop-up menu of 
actions.

Tap to create a new contact. 



Chapter 8  Microsoft Pocket Outlook  8-9

To change the way information is displayed in the list, tap Tools, and then tap Options.
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To create a contact 

4. Tap New.

5. Using the Input panel, enter a name and other contact information. You will need to 

scroll down to see all available fields. 

6. To assign the contact to a category, scroll to and tap Categories and select a 

category from the list. In the contact list, you can display contacts by category. 

7. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For 

more information on creating notes, see “Notes: Capturing Thoughts and Ideas,” 

later in this chapter. 

8. Tap OK to return to the contact list. 

Tap to return to the contact list (the 
contact is saved automatically).

Scroll to see more fields. 

The Notes tab is a good place 

for maps and directions. 
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Using the Summary Screen 

When you tap a contact in the contact list, a summary screen is displayed. 

Tap to view notes.

Tap to change contact 
information.
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Tasks : Keeping a To-Do List

Use Tasks to keep track of what you have to do. 

To change the way information is displayed in the list, tap Tools, and then tap Options.

When you select landscape on the settings you will have a screen as follows :  

(If you want to select “landscape”,  > “Settings” > “System” tab > “Screen ”  icon. 

For more detailed information, see the screen setting on chapter 6 Configuring Device.)

For description below, portrait screens are used. 

Select the sort order of the list. 

Select the category of tasks you want displayed in the list.

Tap to create a new task. 

Indicates high priority. 

Tap to display or edit the task details. 

Tap and hold to display a pop-up menu 
of actions. 
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To create a task 

9. Tap New.

10. Using the Input panel, enter a description. 

11. You can enter a start date and due date or enter other information by first tapping 

the field. If the Input panel is open, you will need to hide it to see all available fields. 

12. To assign the task to a category, tap Categories and select a category from the list. 

In the task list, you can display tasks by category. 

13. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For 

more information on creating notes, see “Notes: Capturing Thoughts and Ideas,” 

later in this chapter. 

14. Tap OK to return to the task list. 

To quickly create a task with only a subject, tap Entry Bar on the Tools menu, and then 

tap Tap here to add a new task.

Tap to return to the task list (the task is 
saved automatically). 

Tap to choose from predefined subjects. 

Notes is a good place for maps 

and drawings.

Tap to hide Input Panel. 
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Using the Summary Screen 

When you tap a task in the task list, a summary screen is displayed. To change the task, 

tap Edit.

View task details. 

Tap to show and hide additional summary 
information.

View notes. 

Tap to change task. 
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Notes : Capturing Thoughts and Ideas

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. 

You can create a written note or a recording. If a note is open when you create the 

recording, it will be included in the note as an icon. If the note list is displayed, it will be 

created as a stand-alone recording.

When you select landscape on the settings you will have a screen as follows :  

(If you want to select “landscape”,  > “Settings” > “System” tab > “Screen ”  icon. 

For more detailed information, see the screen setting on chapter 6 Configuring Device.)

For description below, portrait screens are used. 

Tap to change the sort order of the list.

Tap and hold to display a pop-up 

menu of actions. 

Tap to show or hide the Recording 
toolbar.

Tap to create a new item. 
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To create a note 

15. Tap New.

16. Create your note by writing, drawing, typing, or recording. 

Create your note by writing, drawing, typing, or recording. For more information about 

using the Input panel, writing and drawing on the screen, and creating recordings, see 

“Entering Information Using the Input Panel” in chapter 3. 

These icon display the voice recording.  

Record button 

Display the process of recording. 

Pen buttonTap to show or hide the 

Recording toolbar.
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Your device includes Microsoft Pocket PC Software 2003(Microsoft Pocket Word, 

Microsoft Pocket Excel, Windows Media Player for Pocket PC, Microsoft Reader, and 

Microsoft Messenger). This section provides an overview of these programs and enough 

information to get you started. For complete instructions on using a program, refer to 

online Help for that program. 

In this chapter, you will learn about 

Microsoft Pocket Word 

Microsoft Pocket Excel 

Microsoft Windows Media Player 

Terminal Service Client 

Pictures 

Microsoft Messenger 

Chapter 9

Microsoft Programs
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Microsoft Pocket Word 

Microsoft Pocket Word works with Microsoft Word on your desktop PC to give you easy 

access to copies of your documents. You can create new documents on your device, or 

you can copy documents from your desktop PC. Synchronize documents between your 

desktop PC and your device regularly so that you have the most up-to-date content in 

both locations. 

To use Pocket Word 

1. On the Start menu, tap Programs, and then tap the Pocket Word icon. 

When you select landscape on the settings you will have a screen as follows :  

(If you want to select “landscape”,  > “Settings” > “System” tab > “Screen ”  icon. 

For more detailed information, see the screen setting on chapter 6 Configuring Device.)

For description below, portrait screens are used. 

Tap to show and hide toolbar. 
Tap to make a 
new word file.  
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2. Tap New to open a blank document. 

You can open only one document at a time; when you open a second document, you will 

be asked to save the first. You can save a document you create or edit in a variety of 

formats, including Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt). 

You can enter information in Pocket Word in four modes: typing, writing, drawing, and 

recording. Use the View menu to switch between modes. Each mode has its own toolbar, 

which you can show and hide by tapping the Show/Hide Toolbar button on the 

Command bar. 

Typing Mode. Use the Input panel to enter typed text into the document with either the 

keyboard or the Letter Recognizer. 

For more information on entering typed text, see “Entering Information” in chapter 3. 

Writing Mode. In writing mode, use your stylus to write directly on the screen. Ruled 

lines are displayed as a guide, and the zoom magnification is greater than in typing 

mode to allow you to write more easily. For more information on writing and selecting 

writing, see “Entering Information” in chapter 3. 

Written words are converted to graphics (metafiles) when a Pocket Word document is 

converted to a Word document on your desktop PC. 

Drawing mode. In drawing mode, use your stylus to draw on the screen. Gridlines 

appear as a guide. When you lift your stylus off the screen after the first stroke, you will 

see a drawing box indicating the boundaries of the drawing. Every subsequent stroke 

within or touching the drawing box becomes part of the drawing. For more information on 

drawing and selecting drawings, see “Entering Information” in chapter3.  

Recording mode. Use recording mode to embed a recording into your document. 

Recordings are saved as WAV files. For more information on recording, see “Entering 

Information” in chapter3.  

To open a template rather than a blank document, select a template for new documents. 

On the Tools menu, tap Options, and then browse to select the default template. When 

you tap New, the template appears with appropriate text and formatting already provided.  
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Tips for Working in Pocket Word 

 You can change the zoom magnification by tapping View and then Zoom. Then 

select the percentage you want. Select a higher percentage to enter text and a lower 

one to see more of your document. 

 If you are opening a Word document created on a desktop PC, select Wrap to 

Window on the View menu so that you can see the entire document. 
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Microsoft Pocket Excel 

Microsoft Pocket Excel works with Microsoft Excel on your desktop PC to give you easy 

access to copies of your workbooks. You can create new workbooks on your device, or 

you can copy workbooks from your desktop PC to your device. Synchronize workbooks 

between your desktop PC and your device so that you have the most up-to-date content 

in both locations. Pocket Excel provides fundamental spreadsheet tools, such as 

formulas, functions, sorting, and filtering, which enable you to create simple workbooks, 

such as expense reports and mileage logs. 

To use Pocket Excel 

1. On the Start menu, tap Programs, and then tap the Pocket Excel icon. 

When you select landscape on the settings you will have a screen as follows :  

(If you want to select “landscape”,  > “Settings” > “System” tab > “Screen ”  icon. 

Tap to select a function you want. 

Tap to select a sheet. 

Tap to show and hide toolbar. 
Tap to make a 

new Excel file. 
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For more detailed information, see the screen setting on chapter 6 Configuring Device.)

For description below, portrait screens are used. 

2. Tap New to open a blank workbook. 

To open a template rather than a blank workbook, select a template for new workbooks. 

On the Tools menu, tap Options, and then browse to select the default template. When 

you tap New, the template appears with appropriate text and formatting already provided. 

You can open only one workbook at a time; when you open a second workbook, you will be 

asked to save the first. You can save a workbook you create or edit in a variety of formats, 

including Pocket Excel (.pxl) and Excel (.xls). 

Tips for Working in Pocket Excel 

 View in full-screen mode to see as much of your worksheet as possible. Tap View 

and then tap Full Screen.

 If your workbook contains sensitive information, you can protect it with a password. 

To do so, open the workbook, tap Edit, and then tap Password.

 Freeze panes on a worksheet. First, select the cell where you want to freeze panes. 

Tap View and then tap Freeze Panes. You might want to freeze the top and leftmost 

panes in a worksheet to keep row and column labels visible as you scroll through a 

sheet. 

 Split panes to view different areas of a large worksheet. Tap View and then tap Split.

Then drag the split bar to where you want it. To remove the split, tap View and then 

tap Remove Split.

 Show and hide rows and columns. To hide a row or column, select a cell in the row 

or column you want to hide. Tap Format, then tap Row or Column, and then tap 

Hide. To show a hidden row or column, tap Tools, then tap Go To, and then type a 

reference that is in the hidden row or column. Tap Format, then tap Row or Column,

and then tap Unhide.
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Microsoft Windows Media Player 

Use Microsoft Windows Media Player for Pocket PC to listen to digital audio and video 

files, such as songs or movie clips.  

Media Player supports file formats, such as MP3, WMA, WMV, ASF and WMP. 

To start Windows Media Player 

On the Start menu, tap Programs, and then tap the Windows Media Player icon.

When you select landscape on the settings you will have a screen as follows :  

(If you want to select “landscape”,  > “Settings” > “System” tab > “Screen”  icon. 

Indicates the progress of the 
current track.

Tap to go back to the previous file.

Tap to play a previous song.

Tap to skip to the next file.

Tap to fit window.

Tap to select a song 

you want to playback.

To play the music file repeatedly, on the Menu, Shuffle/Repeat and select Repeat. 

Tap to adjust volume.

Tap here to see movie files through streaming and you will 
be connected to www.windowsmedia.com
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For more detailed information, see the screen setting on chapter 6 Configuring Device.)

For description below, portrait screens are used. 

Connect to Windowsmedia.com 

Tap  to connect to www.windowsmedia.com.

Playlist

Tap “Menu” > “Library” to have screen displayed as below.  

Tap “My Music” 

Select the file 

you want. 
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 Tap “All Music”. 

Tap “Now Playing” to see what is played.  

Working with Audio Files on a SD Card 

Because songs and audio files can use a lot of storage memory, you may store them on a 

mini SD memory card. 

Tap Play.

Delete. 

Display all music files. 

Move files up or down. 

This is the same as tapping 
“Properties” on the Men. 
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Tap to set the size of screen when 

playing back a video file. 

Select Elapsed or Remaining 

Select one of options your want : 

 Never 
 Only when oversized 

 Always 
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Assign buttons 

On the Menu, tap Options > “Buttons” tab to get the settings of button mapping. 

The assigned buttons are limited to , and the description word means as follows :  

Action  means to press 

 means to press the up of

Left  means to press the left of 

Hold Left  means to press and hold the left of 

Play/Pause 

Stop
Pause

Previous 

Next 
Volume Up 

Volume Down 

Mute
Full Screen 

Fast Forward 

Rewind 
Screen Toggle

Tap this to have the assigned button disabled. 

First select the function you want and then 

select “None” 
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Using Terminal Services Client 
Using the Terminal Services Client (TSC), you can log onto a desktop computer running 

Terminal Services (pre-Windows XP) or Remote Desktop (Windows XP and later) and 

use all of the programs available on that computer from your mobile device. 

Connecting and Using TSC 

Before attempting a Terminal Services connection, you must have authorized access to 

a desktop or server that supports this service. 

1. Launch TSC 

Transcriber is not supported as an input method during a Terminal Services 

session.  You must use Keyboard, Block Recognizer, or Letter Recognizer. 
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2. Enter the IP address or host name of a valid TS server.  Checking Limit size of 

server… attempts to compress the remote desktop screen to minimize scrolling.  Press 

Connect to start connection. 

3. Typically you will be asked to login.  Do so using one of the acceptable input 

methods. 

4.  If server desktop size is not in optimized mode, you can use one of the five 

 buttons to jump to the indicated positions on the screen. 

Otherwise, you can tap and hold on the screen to get those same options in a context 

menu form. 

5. Use the remote server as if you were using it directly. 
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Pictures 
Use Pictures to view JPEG pictures stored on your device or in a storage card, send 

pictures to others, view a slideshow of your pictures, or set a picture as the background 

on the Today screen.  You can even set Pictures to launch itself when a digital camera 

storage card is inserted into your device! 

To begin, run Pictures and either choose to view main memory or storage card contents.  

By tapping and holding on an image, you can create a clone of that file, delete that file, 

select all files, send file via e-mail, beam picture, or rename the image. 
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If you choose to Rename, type in the new file name. 

Working with Images 

Single clicking on a thumbnail presents a zoomed-in version of the picture. 

From here, you can rotate, crop, zoom, share, or change brightness and contrast levels 

of a picture. 

Image Tools 

Both Beam Picture and Send via e-mail allow you to share your pictures. 

Set as Today Wallpaper… will set the loaded image as your Today screen background. 

An improperly sized image will not appear without distortion on the Today screen. 
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You will be able to either crop the image to fit to the Today screen (for large images) or 

fit to screen (for small images).  You can also set the transparency level so that Today 

screen content is still legible. 

Above is the result of our Today screen. 

Revert to Saved discards all changes since the last saving of the image and displays 

the original image. 

Save Picture As…performs a save operation on the picture. 
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i. Choose the file name and destination for the image then select OK.

ii. Image quality might decrease as a result of the save process, so you are reminded 

of this when saving. 

Options: See below 

Editing Images 

Pictures allows you to rotate, crop, and adjust brightness and contrast levels of your 

pictures.

Rotating Images 

1. Press the  button. 
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2. The picture will be rotated 90 degrees counter-clockwise. 

Cropping Images 

1. Press the  button. 

2. Draw a box with the stylus around the area you wish to crop and save. 

3. Tap once inside the box you have drawn and your picture will be cropped. 



Chapter 9  Microsoft Programs  9-19

Zooming into Images 

1. Press the  button to raise the Zoom panel.  By default your image is in Best Fit

view mode when you open the image. 

2. Pan around the red boxed area to focus a portion of the picture into view. 

3. Press the  button to zoom in or the  button to zoom out of the area 

highlighted by the red box. 

4. Press the  button to return to Best Fit view mode. 

Undoing Changes 

Press Edit—Undo or Edit—Redo to undo or redo the last change made. 
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Changing Image Brightness and Contrast 

1. Select Edit—Brightness and Contrast

2. Select the Brightness Up, Brightness Down, Contrast Up, or Contrast Down

button.  With each change in brightness or contrast level, Edit—Undo will undo that last 

change. 

3. Press Done to save changes or Cancel to cancel changes. 

Viewing Images in a Slideshow 

With the click of a button, you can create a slideshow of the images located in a folder to 

present to friends, family, or co-workers. 

1. From the main Pictures window, press the  button. 

2. Automatic playback in vertical viewing mode will begin. 
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3. To manipulate the slideshow, single tap anywhere on the screen. 

Above is a description of each of the buttons 

4. To change from vertical to horizontal viewing mode, press the Flip view button. 
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Configuring Pictures 

Tools—Options from either the main screen or while viewing an image allows you to set 

various properties about image display and slideshow playback. 

In the General tab, you can turn on dithering to improve image display for Pocket PCs 

with less than 16-bit color screens.  A useful feature is that Pictures can launch itself 

when a digital camera storage card is inserted. 

In the Slide Show tab, you can change the delay between slides or turn on the 

slideshow as a screensaver when your device has been idle a set amount of time. 
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 MSN Messenger 

MSN Messenger is an instant messaging program that lets you see who is online, send 

and receive instant messages and have instant message conversations with groups of 

contacts. 

To use MSN Messenger, you must have a Microsoft Passport account. If you have a 

Hotmail® or MSN account, you already have a Passport. Once you have obtained a 

Microsoft Passport, you are ready to set up your account. 

To set up an account and sign in 

3. On the Start menu, tap Programs, and then tap the MSN Messenger icon. 

4. To sign in, tap the sign-in screen and enter your e-mail address and password.  

Tap here to sign in. The account you entered before displays. 

Sign up for a Microsoft Passport account at http://www.passport.com . Get a free 

Microsoft Hotmail e-mail address at http://www.hotmail.com.

If you already use MSN Messenger on your desktop PC, your contacts will show 

up on your device without being added again. 
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When you select landscape on the settings you will have a screen as follows :  

(If you want to select “landscape”,  > “Settings” > “System” tab > “Screen ”  icon. 

For more detailed information, see the screen setting on chapter 6 Configuring Device.)

For description below, portrait screens are used. 

Working with Contacts 

The MSN Messenger window shows all of your messenger contacts at a glance, divided 

into Online and Not Online categories. From this view, while connected, you can chat, 

send e-mail messages, block the contact from chatting with you, or delete contacts from 

your list using the pop-up menu. 

Tap and hold to display a pop-up menu of 

actions.

Tap a contact to start a chat. 

To make a new name for chat, tap 

Options on the Tools menu. 

To see others online without being seen, on the Tools menu, tap My Status, and 

then tap Appear Offline.

If you block a contact, you will appear offline but will remain on the blocked 

contact’s list. To unblock a contact, tap and hold the contact, then tap Unblock

on the pop-up menu. 
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Editing My Text Messages 

Tap Edit My Text Messages on the Tools menu to enter a preset message. 

Chatting with Contacts 

Tap a contact name to open a chat window. 

Enter your message in the text entry area at the bottom of the screen (or tap My Text to

enter a preset message), and then tap Send. To invite another contact to a multi-user 

chat, on the Tools menu, tap Invite, and then tap the contact you want to invite. 

Contacts icon 

The message you enter 

display here. 

Text entry area 

To switch back to the main window without closing a chat, tap the Contacts 

button. To revert to your chat window, tap Chats, and then select the person with 

whom you were chatting. 

Select a message among the list 

that is preset. 
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Adding a Contact 

To add a new contact, tap Add a Contact on the Tools menu.
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Set Options 

On the Tools menu, tap Options. On the Accounts tab, enter your Passport account 

information.

Enter your name for chat. 



POZ Camera to snap a 

picture and save it POZ Camcorder to record a video file and save it using the digital camera lens and POZ 

Album to edit, save and manage the pictures you snap.  

In this chapter, you will learn about 

POZ Camera 

 POZ Camcorder  

POZ Album 



 POZ Camera 

POZ Camera helps you to snap a picture and save it using the digital camera lens.  

You can open POZ Camera program as follows : 

 Start  button > Programs > “POZ Camera”  icon. 

 Select the “POZ camera “on the POZ Launcher. 

 Select the shortcut  for POZ camera on the POZ Camcorder program. 

Tap the shutter button when the subject is framed. 





Save pictures 

If you want to enter the View mode, tap “Capture mode/View mode”  icon and tap again to return to the Capture 
mode.

To save the pictures you snapped, tap “save”  icon on the command bar or select “save” or “save all” on the Photo 
menu. 

Tap OK to save. The default folder is File Store\Photo.



Shortcuts provided on the keypad for each function of POZ camera  
When POZ camera program opens and it is in the Capture mode, you can have the shortcut for each function on the 
keypad. 

For example, press on the keypad in the Capture mode to snap a picture. 

When POZ camera program opens and it is in the View mode, you can have the shortcut for each function on the 
keypad. 

For example, press on the keypad in the View mode to open POZ Album program. 



Shortcut for POZ Album  

Tap “Shortcut for POZ Album”  icon on the command bar to open the POZ Album program which helps you to 
view the stored pictures.  

Settings 

Tap “Setting” on the Tools menu to set POZ Camera program.  

Tap OK to save on Screen size, the maximum number of images, Timer, Brightness, button and shutter sound. 



 POZ Camcorder 

POZ Camcorder helps you to record a video file and save it using the digital camera lens.  

You can open POZ Camcorder program as follows : 

 Start  button > Programs > “POZ Camcorder ”  icon. 

 Select the “POZ Camcorder “on the POZ Launcher. 

 Select the shortcut  for POZ Camcorder on the POZ Camera program. 

Tap the shutter button when the subject is framed. 

 

Shortcut for POZ 



Playback 

Select the file you want on the List menu to playback.  

Tap “Capture mode/View mode ” icon to return to Capture mode.  



Make a new album 
The file you have recorded on the Capture mode will be saved in “File Store\video” folder.

Tap “File Manage” on the File menu or tap “File Manage”  icon on the command bar to make a new album.  

Tap “Add” to select the items you want to add.  

After selecting the file you want, tap OK. 



Tap OK to save the video album. 

Tap the playback  button to playback all video files saved on the video album. 

Open video file 
Select the files you want on “File Store\video” folder to open among the existing video file a file which is not saved 
on the video album.

Tap “Open File”  icon on the View mode to open a file you want. 

Select a file you want and tap OK to return to normal.  

Tap the playback  button to playback the file you have selected. 



Shortcuts provided on the keypad for each function of POZ Camcorder  
When POZ camcorder program opens and it is in the Capture mode, you can have the shortcut for each function on the 
keypad. 

For example, press on the keypad in the Capture mode to snap a picture and pause. 

When POZ camcorder program opens and it is in the View mode, you can have the shortcut for each function on the 
keypad. 

For example, press on the keypad in the View mode to .



Options 

Tap “Options”  icon in the Capture mode to optimize POZ Camcorder program.  



POZ Album 

POZ Album helps you to edit, save and manage the pictures you snap using the digital Camera lens.  

Open POZ Album 

You can open POZ Album program as follows : 

 Start  button > Programs > “POZ Album”  icon. 

 Select “POZ Album “on the POZ Launcher. 

 Select the shortcut  icon for POZ Album on the POZ Camera program.  



Open the Photo folder 

File Store\Photo



Edit File 

Tap “Edit mode”  icon on the command bar. 

Make a new album 



Open the existing album 

Tap “Open Album” to open the existing album. 



Slideshow 

Tap “Slideshow” on the Tools menu to have slideshow display the saved list. You can choose whether the 

slideshow automatically displays the next picture in sequence after short delay which is set on options

Options 

Tap “Options” on the Tools menu to set options. 
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Web site 

You can obtain product information as well as tips and hints on how to get more from the 

product at our Web site. This computer service is provided free of charge; you pay only 

for telephone charges and Internet service fees. To connect to this Web site from a 

computer via the Internet, go to www.cb.co.kr.

Service 

For diagnostic instructions and other service information, contact one of the technical 

support numbers. Please do not ship your device for service without first contacting a 

CYBERBANK office. If your device qualifies for in-warranty service, be ready to supply a 

dated proof of purchase.  

Before you contact us for help, be sure to: 

1. Review the manuals whenever possible. 

2. Have the following information about the product: 

 model number 

 serial number 

purchase date

3. Have your product ready to use. The support personnel may ask you to run tests 

and other operations. 

4. Organize your question or problem. The more detailed information you can provide, 

the quicker the support personnel can help you. 

Chapter 11

Support & Service
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Hardware Specifications 

Items Descriptions 

OS Pocket PC 2003 second edition – English version 

PDA PXA255 –400MHz (Cotulla) 
Processor 

CDMA MSM5000 

Phone Module CDMA2000 1xRTT  

ROM Flash Memory(160Mbyte) 
Memory

RAM SDRAM(64Mbyte) 

Main Li-Ion 1800mAh 

Battery
Backup

Li-Ion 100mAh,  
Time for charging : 3 hours 
Charge by Main battery or the external power 

Size (mm) 

width length height 
159 x73 x 21.8 

Weight (g) 340g 

Resolutions 240 X 320 
Screen 

Color 3.5 " Reflective, TFT LCD 65K Color 

External Power 110~220V(charging : 800mAh) 

Cradle 

DC 12V, 1.3A 
Charging the main and backup battery at the same 
time
Time for charging the backup battery : max 3 hours 

USB
(Universal Serial Bus) 

Host/Client 

SD/MMC 1 slot 

CF 1 slot 

PCMCIA Support PCMCIA pack(typeI) 

I/O
Connector 

IrDA 115Kbps 

For Stand-by 80~200 hours 

For voice communications 4 hours (PDA Sleep mode) Time 

For PDA 12 hours(Phone stand-by mode) 

LED
Battery charging status (Red, Blue) 
Phone Status (Red, Green, Blue) 

Sound Stereo while using headset 

For voice communications 
Speaker 

For PDA alarm 

Vibrator instead of phone ring 

Microphone For voice communications & recording 

Interface Connecter USB Client, Power, DM Port, Serial 

Operating Conditions 
Temperature : -20 ~ 50

Humidity : 0 ~ 90% 

Appendix A
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Warranty 

Important: This is your hardware product warranty statement. Read it carefully. Warranty 

terms may be different in your country. If so, your authorized dealer or sales and service 

office can give you details. 

One year limited hardware warranty 

CYBERBANK warrants this hardware product against defects in material and 

workmanship for a period of one year from receipt by the original end-user purchaser. If 

CYBERBANK receives notice of the above-defined defects during the warranty period, 

CYBERBANK will either, at its option, repair or replace products that prove to be 

defective. Should CYBERBANK be unable to repair or replace the product within a 

reasonable amount of time, the customer's alternate exclusive remedy shall be a refund 

of the purchase price upon return of the product. 

Limitation of warranty 

The above warranty shall not apply to defects resulting from: misuse; 

unauthorized modification; opening for any reason; operation or storage outside the 

environmental specifications for the product; in-transit damage; 

improper maintenance; or defect resulting from use of non-CYBERBANK software, 

accessories, media, supplies, consumables, or such items not designed for use with the 

product. 

CYBERBANK makes no other express warranty, whether written or oral, with respect to 

this product. 

Any implied warranty of merchantability or fitness for a particular purpose is limited to the 

one-year duration of this written warranty. 

Some states, provinces, or countries do not allow limitations on how long an implied 

warranty lasts, so the above limitation or exclusion may not apply to you. 

This warranty gives you specific legal rights, and you may also have other rights that 

vary from state to state, province to province, or country to country.  

Appendix B
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CYBERBANK Software Product License Agreement and 

CYBERBANK Software Product Limited Warranty 

This CYBERBANK product contains preinstalled software programs. Please read the 

CYBERBANK Software Product License Agreement before proceeding. 

Important: Carefully read this License Agreement and the Limited Warranty statement 

before operating the equipment. The rights to the software are licensed, not sold. 

CYBERBANK or its licensors continue to own all intellectual property rights to the 

software, and you will be granted certain rights to use the software upon your 

acceptance of this license. Rights in the software are offered only on the condition that 

you agree to all terms and conditions of the License Agreement. Operating the 

equipment indicates your acceptance of these terms and conditions. If you do not agree 

to the terms and conditions of the License Agreement, return the complete package for a 

full refund now. 

CYBERBANK Software Product License Agreement

The CYBERBANK Software Product License Agreement shall govern the use of all 

software that is provided to you, the customer, as part of this CYBERBANK product with 

the exception of Microsoft Software. Microsoft Products are licensed to you under the 

Microsoft End User License Agreement (EULA) contained in the Microsoft 

documentation. Any third-party software supplier's warranty terms that may be found 

online, or in any documentation or other materials contained in the product packaging, 

shall govern the use of that third-party software. 

Use

You may only use the software on a single computer. You may not reverse, assemble, or 

decompile the software. 

Copies and adaptations 

You may make copies or adaptations of the software (a) for archival purposes, or (b) 

when copying or adaptation is an essential step in the use of the software with a 

computer so long as the copies and adaptations are used in no other manner. 

You have no other rights to copy unless you acquire an appropriate license to reproduce 

which is available from CYBERBANK for some software. 

You agree that CYBERBANK provides no warranty, free installation, or free training for 

any copies or adaptations made by you. 

All copies and adaptations of the software must bear the copyright notice(s) contained in 

or on the original. 
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Ownership

You agree that you do not have any title to or ownership of the software, other than 

ownership of the physical media. You acknowledge and agree that the software is 

copyrighted and protected under the copyright laws. 

You acknowledge and agree that the software or part thereof may have been developed 

by a third-party software supplier named in the copyright notice(s) included with the 

software, who shall be authorized to hold you responsible for any copyright infringement 

or violation of this or their own License Agreement. 

Transfer of rights in software 

You may transfer rights to the software to a third party only as part of the transfer of all your 

rights and only if you obtain the prior agreement of the third party to be bound by the terms of 

this License Agreement. Upon such a transfer, you agree that your rights to the software are 

terminated and that you will either destroy all your copies and adaptations or deliver them to 

the third party. Transfer to a U.S. government department or agency or to a prime or lower 

tier contractor in connection with a U.S. government contract shall be made only upon prior 

written agreement to terms required by CYBERBANK. 

Sublicensing and distribution 

You may not lease, sublicense the software, or distribute copies or adaptations of the 

software to the public in physical media, by telecommunication or at all without the prior 

written consent of CYBERBANK. 

Termination 

CYBERBANK may terminate this software license for failure to comply with any of these 

terms, provided CYBERBANK has requested you to cure the failure and you have failed to do 

so within thirty (30) days of such notice. 

Updates and upgrades 

You agree that the software does not include updates and upgrades that may be available 

from CYBERBANK under a separate support agreement. 


